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Using MusicMaster and the ‘I Like Music’ Store 
 
With the new MusicMaster/I Like Music integration in Pro Version 8, you can search for and 
download high quality licensed music right from within MusicMaster. In addition, songs and 
their metadata can be added to your library automatically upon download  
 

 
 
This document provides a full walkthrough on setting up and using the Music Store. It will cover 
the following sections: 
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1. FAQ About “I Like Music” 
 
I Like Music (ILM) is one of the largest broadcast and production music libraries in the world, 
delivering high quality uncompressed audio files and associated metadata.  
 
What Kind of Music is Available? 
While ILM is a UK-based company, their collection contains millions of tracks from around the 
world, including every chart hit since 1952. You will also find multiple versions of songs, 
including remastered and live performances.  
 
ILM also delivers weekly updates with new hits from across major charting services and sources 
like Billboard, Spotify, Apple, Amazon, and other popular music lists, and pre-releases from 
music labels. 
 
Is the Music Licensed for Broadcast? 
I Like Music is a B2B service that supplies commercial and production music for broadcast and 
public performance. The service is intended for licensed broadcasters, including radio, TV, web 
streams, school, in-store, event or background music programming. ILM does not permit 
downloads for personal use only. 
 
When you purchase a track, ILM pays the dubbing fees (mechanical license), which permits the 
music to be used by your organization for public broadcast. Note that while ILM registers music 
through the UK-based PPL/PRS, the resulting license applies globally. 
 
As with any other music you broadcast, you will still be responsible for reporting individual 
airplay to the appropriate Performance Rights Organizations in your region. You'll find 
templates to help you do this in MusicMaster's Special History Reports section. 
 
What is the Audio Format? 
ILM downloads are in a high-quality uncompressed wav format. Note that songs are not pre-
adjusted for broadcast levels, as these may vary. However, you can use the new Audio Editor in 
MusicMaster to normalize levels and trim silence.  
 
What Does it Cost? 
You can buy one download credit at a time or purchase a multi-pack for a bulk discount 
(available in 25, 50, 100 or 500 credit packs).  
 
Prior to processing fees, the cost of a single credit in USD is approximately $1.15, or as low as 
$0.82 when you purchase 500 credits. Metadata can be accessed and downloaded without 
additional fees.  
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What Kind of Metadata is Available? 
The following table lists the metadata which may be available on an ILM song, along with a 
description and sample.  
 

Metadata 
Field 

Description Sample Value 

Audio 
Filename 

Audio filename (the original ILM 
filename)  

Katy_Perry--Teenage_Dream__Album_Version_.48049-01.01.wav 

Song Title Title of song/track Teenage Dream (Album Version) 

Artist Artist of song/track Katy Perry 

Release 
Year 

Release year of song/track 2010 

Genre Genre of song/track Pop 

Album Title Title of product (Album/CD/etc) 
Will be the same as the Song Title for a 
single release 

Teenage Dream 

Album 
Artist 

Product artist name Katy Perry 

Album Year Release year of product 2010 

Album 
Genre 

Genre of product Pop 

TrackNo Track number of this song within 
product 

1 

Record 
Label 

Record label/company name Virgin 

Musical 
Work 

Title of musical work 
Title as registered with a rights body 

Teenage Dream 

Composer List of composers Gottwald, Lukasz/Max, Martin/Perry Katy,/Mc Kee, Bonnie Leigh 

Publisher List of publishers  Kasz Money Publishing/Kobalt Music Services America Inc/Kobalt 
Music Publishing Limited/When I'm Rich You'll Be My Bitch 

Mechanical 
Rights 

List of mechanical rights owners Kobalt Music Publishing Limited (Mcps), Warner/Chappell North 
America Limited (Mcps), Universal/Mca Music Limited (Mcps), Bmg 
Rights Management (Uk) Limited (Mcps) 

Performing 
Rights 

List of performing rights owners Lukasz Gottwald (Prs), Martin Max (Prs), Perry Katy (Prs), Bonnie 
Leigh Mc Kee (Prs), Benjamin Levin (Prs), Kobalt Music Publishing 
Limited (Prs), Warner/Chappell North America Limited (Prs), 
Universal/Mca Music Limited (Prs), Bmg Rights Management (Uk) 
Limited (Prs) 
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ISRC ISRC Number (International Standard 
Recording Code) Unique ID for this 
song/track. Requested on many Special 
History Reports 

USCA21001255 

ISWC ISWC Number (International Standard 
Musical Work Code) Unique ID for this 
musical work/composition. Requested 
for some Special History Reports 

T9049913180 

EAN EAN Number (European Article 
Number). This is the product barcode 
number with an extra digit for the 
country code. Requested for some 
Special History Reports 

5099990741029 - 5099990741029 

Tunecode Tunecode Number - This is a musical 
work ID code similar to ISWC, but 
assigned by PRS (Publishing Rights 
Society) or MCPS (Mechanical 
Copyright Protection Society). 
Requested for some Special History 
Reports 

076229CP 

 
What Is the MusicMaster Music Store Integration? 
The integration provides you with the following abilities: 

1. You can access the ILM Music Store web interface right from within the MusicMaster 
application to search for songs, browse genres and charts, purchase credits and 
download tracks 

2. You can also right-click on any song in your library to search the Store for that exact 
track, title, artist, or album 

3. You can configure MusicMaster to automatically add downloaded songs to a specified 
category in your library and automatically add available metadata to the fields you have 
mapped. This is the recommended usage. 

4. Optionally, you can download songs without automatic ingest and retrieve the 
metadata later, once the song has been added to MusicMaster (such as by your 
automation system) 

5. You can also look up or fill-in missing metadata for any previously existing song in your 
library for no additional cost 

 
How Does It Work? 
You will specify a special download folder when you set up the Music Store. While MusicMaster 
is running, it will be watching for files with an ILM ID in the filename. If you have Auto-Ingest 
turned on, whenever an ILM song is downloaded, moved or copied into this folder, it will be 
added to the open MusicMaster database. After the ingest has occurred, you are free to move 
and rename the file as you wish.  
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Can I Use the Songs for More Than One Station? 
Yes. Songs will be automatically added to whatever database you currently have open. If you 
open another station database that uses the same download folder, you can use a tool called 
“Scan for Missing Files” to find and add those songs to your library. Or you may choose to 
create multiple download folders for each station, and copy/paste songs between them.    
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2. Configuring Music Store Settings  
 

Enable the Music Store 
To start, the store must be enabled within each station that you wish to use it with. This is done 
in Tools, Options, Music Store Options. Check the checkbox for “Enable the MusicMaster Store” 
to make the store available within this station.  
 

 
 

Choosing A Metadata Ingest Mode 
Use the dropdown to select the “Metadata Ingest Mode” which determines if and when you 
want songs and metadata to be added to MusicMaster. The three options are: 
 

• 1. Disabled: Songs you’ve downloaded will not be added to MusicMaster automatically. 
If you wish to add them at a later date, you can turn Auto Ingest on and then use the 
“Scan For Missing Files” button to retrieve any songs in your specified download folder 
that you’ve downloaded from the ILM Store. 
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• 2. Add songs for downloaded audio files: This should be the mode you use unless you 
have a specific need or automation interface that requires option 3. This mode causes 
MusicMaster to watch the contents of the designated Download folder for new audio 
files to appear that have an ILM ID in the filename. You will download audio files from 
the store and save them to that folder. When MusicMaster sees those files appear, it 
will read the file, get the full store metadata and add a new song card to MusicMaster 
with all of that information according to the field mapping you can set up here.  

• 3. Update songs when filenames are added: Use this mode if you have an automation 
system that ingests new music first, changes the filename, and then syncs new songs to 
MusicMaster using Nexus. When you use this mode, new songs won’t also be added to 
MusicMaster first, which would have created a duplicate copy after the automation 
system adds them second. Instead, using Nexus, the automation system will store a 
copy of the original store filename which will then be added to MusicMaster under your 
specified Audio Filename field. This will be used as a reference, so once the song is 
added to MusicMaster by your automation system, MusicMaster will automatically 
retrieve the metadata from the ILM Store. Note that if you use this method and your 
automation system changes filenames when ingesting music, then you should create a 
new, separate field to hold the Store Filename and map it to the Audio Filename field in 
the Music Store Settings. That way your main Audio Filename field can contain the 
actual audio filename that was created by the automation system, which will be used 
for audio playback.  

 
Note: This third “update” method is currently supported by PlayoutOne Pro with Nexus. If you 
need this for another automation system, contact Support. In the meantime, one suggested 
workaround would be to use method 2. The song will be added to MusicMaster first. Then, once 
a second copy is added by your automation system, you can use the Merge Songs tool (right-
click menu) to combine data from the two song cards.  
 
 

Select a Download Folder 

You must specify the folder where you will be downloading your audio files from the store. This 
defaults to the Windows Downloads folder. But you can use the [...] button to select another 
folder and you can use the folder icon to preview the contents of this folder. Note that if you 
are using the Update Songs ingest mode, you may need to specify the folder that your 
automation system watches for new songs. 
 
When you first download a song, the Music Store browser will point to Windows Download 
folder by default, but once you save a file to a different location, it will remember that location 
for the future.  
 
Note: It’s also important that you don’t change the song filename when saving it, as 
MusicMaster looks for the ILM ID in the filename.  
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What if I save the files to the wrong folder? 
If you accidentally save files to a folder other than the one you have specified here, no auto-
ingest will occur. However, should this happen, you can move/copy the songs into the correct 
folder, and MusicMaster will ingest them, so long as the database is open. Or you can use the 
“Scan for Missing Files” button to retrieve them after you open the database.  
 
Can I move songs or change their filename later?  
Yes. Once you’ve downloaded the audio files to the watched folder and they’ve already been 
ingested into MusicMaster, you can move the files to another folder or change their name if 
you need to. This will not affect the song or metadata already in MusicMaster. However, if you 
do change the location or filename, you’ll probably want to update your audio filename field 
with the new file path and name.  

 
Choose A New Song Category 
Next, select the category you want MusicMaster to add downloaded songs to. You can also click 
the plus sign to create a new category for this purpose. The default is your Uncategorized 
folder.  
 

Map Metadata Fields 
In the Field Mapping table, use the dropdown on the right to match your MusicMaster fields to 
the available ILM metadata. Note that you do not need to map every single field, just the ones 
that you want/need.  
 
If you need to create new database fields to hold some metadata, you can do this by going to 
the menu Dataset, Library, Fields and clicking the Add New Field button. 
 
Remember that if you are using an automation system that changes your audio filenames, you’ll 
want to create a separate Store Filename field to contain the Audio Filename from ILM, which 
will be used for reference only and not audio playback.  
 

Scan For Missing Files 
Beneath the field mapping table, you’ll find the Scan For Missing Files button, which has been 
referred to earlier in this guide. This button is used to scan your download folder for any ILM 
songs which haven’t already been added to that MusicMaster station library. If you wish, you 
can check the checkbox to have this scan performed each time you open your database.  
 
Remember, you should not need to use this button often. It’s only needed in cases where you 
downloaded or moved a song into your specified download folder while the target station 
database was not open.  
 
Your Music Store configuration is now complete. Click Apply to save the changes. 
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Optional: Configure Audio Playback 
If you wish to playback and edit audio in MusicMaster, you need to tell the Audio Player where 
to find your files. This setup can be done in Tools > Options > Audio File Options.  
 
Under Audio Filename Location, use the dropdown to select the MusicMaster field where your 
filename is stored. Depending on how you store that information in MusicMaster, you have two 
options here:  

1. If your filename field only contains the filename and not the full path, you’ll need to add 
the full folder path here first. Type in the path (e.g. C:\AUDIO\) and then use the 
dropdown to fill in the appropriate field.  
 

 
 

 
2. If your audio filename field data already contains the full path, you can simply select the 

field, as shown here: 
 

 
 
If you need help with more advanced setup, such as combining multiple fields, or using only part 
of a field’s data, contact MusicMaster support.  
 
If you have done everything correctly, you will be able to hit F12 on a selected song to start 
playback, and Shift+F12 to load that song into the built-in audio editor. You can also open the 
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Audio Player using the View menu. In addition, you can access audio playback functions in the 
Tools menu or by right-clicking on any song in the library or schedule editor.  
 
Next, we’ll look at how to open the store and get started with an I Like Music Account.   
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3. Getting Started with I Like Music  
 
Once the store is Enabled, you can now launch the Music Store panel using the ILM icon on the 
toolbar, or selecting Music Store from the View menu.  
 

 
 

Using the Store Browser Panel 
The Music Store panel works very much like the normal Web Browser panel but is limited to 
only viewing the Music Store.  

 
 
You can move and dock the Store panel wherever you like, drag the left edge to resize it, or 
click the pin icon on the top right to collapse it to the edge of the screen and hover to re-open.   
 
If you want to have both the Music Store and the Web Browser open at the same time, you can 
click and drag one over the other to create two separate tabs of the Browser panel.  
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Creating a Store Account 
To use the Music Store, you will need to create an I Like Music account. You can sign up right in 
the Music Store panel in MusicMaster by clicking on the menu button in the upper right, and 
then clicking Sign Up.  
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Note: If needed, you can also access I Like Music on the web at https://web.ilikemusic.com, 
however it is recommended that you only use I Like Music inside of MusicMaster.  
 
Next complete the sign-up form.  

https://web.ilikemusic.com/
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As shown below, fill in your name, title and email address. Please note that the email address 
you use here will be your username for the service and you will need to receive an email sent to 
this address to complete the signup process. 
 
In the Service Type dropdown on the signup page, please make sure you select “MusicMaster”.  
 
Once you select the service type, the sign-up form will show additional fields you must fill in. 
These are used for verification purposes by I Like Music.  
 
Important: In the box for “How did you hear about ILM?” you must also enter the special 
code MM01 to link your account to MusicMaster.   
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After you’ve filled out the entire form, reviewed the terms and conditions and checked the box 
to indicate that you have done that, you can click “Sign Up” to complete the process. 
 
You should now receive a registration message at the email address you provided. Note that 
this email will come from: media@ilikemusic.com. There will be a link in the email to establish a 
password for your account. Once you have established your account, you can now use the 
Music Store panel within MusicMaster using this same login.  
  

mailto:media@ilikemusic.com
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4. Using the Music Store 
 

Log Into the Store 
Click the Log In button on the top right to enter your account email and password. When you 
first log in, you’ll have the choice to select either Commercial or Production Music. Your ILM 
account will also allow you to browse their library of stock production music, however if you 
download these files, they will not be ingested into MusicMaster. For the purposes of this 
training, select Commercial Music.  
 

 
Purchase Store Credits 
Now that you have an account, you can freely search and browse the service, but you must 
purchase credits in order to download audio files.  
 
Every song downloaded costs one credit. The price of the credits varies based on how many you 
purchase at once, with discount prices for buying larger multi-packs. Credits may be purchased 
in quantities of: 1/25/50/100/500 
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Prices are in British ponds. With current conversion rates, the cost of a single credit in USD is 
approximately $1.11 (£ 0.84) when you only buy one credit, or as low as $0.79 per credit 
(£ 0.60) when you purchase 500 credits. Additional PayPal or credit processing fees may apply. 
 
To buy credits, click the menu (upper-right corner) and select Buy Credits.  
 

 
 
Note that if you’ve made your window wide enough, all the menu options will be listed across 
the top, like this:  
 

 
 
 From the popup, select the quantity you’d like to buy at once.  
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Continue to login to PayPal or create an account and then proceed to check out using your 
PayPal account or credit card.  
 

 
 
If you decide to abort the purchase, you can click the link labeled “Cancel and Return to I Like 
Music” at the bottom of the screen.  
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Once you have completed the purchase, you can click the Return to Merchant button at the 
end to return to the start page where you started the transaction. 
 
Once you have your credits, you can freely download songs from the store until your credits are 
all used up. If you attempt to download an audio file without any credits available, you will 
receive a message at the top of the Store panel prompting you to purchase more.  
 

Searching For Songs in the Store 
Upon clicking Commercial Music, you will be brought to the Search page. You can fill in specific 
fields like Artist or Album, or use the Free Search box to enter any values to match. You can also 
click on Genre or Year to bring up a selection list.  
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Searching From the MusicMaster Library 
You can also search for songs directly from your MusicMaster library.  To do this, right click on a 
song in the library and use the Store options on the context menu. Note that this will open the 
store panel if it is not already open and you will need to login to your store account before you 
will be able to continue. 
 
Find New Music By Same Artist, Title or Album 
Use the Find New Songs option to search the store for the same artist, title or album as the 
selected song.  
 

 
 
 
Search For the Selected Song 
You may also use Choose Find Selected Song to search for the same song. You may want to use 
this to replace the audio file or metadata.   
 
If you are selecting a song from your library that wasn’t previously purchased in the Music 
Store, you can search by Artist/Title. If you need an exact match of the specific recording you 
are using, be sure to check the metadata for the correct version.    
 
If you select a song that you already purchased from the ILM store, you can Search for song by 
ID. For ILM store songs, you’ll also see an additional option called “Refresh Metadata”. When 
you click this, MusicMaster will find the exact song by ID and automatically fill in any missing 
metadata.  
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Releasing Selected Song 
Note that when you use Find Selected Song to search the store, MusicMaster creates a link 
between the selected song card and the very next thing you download from the store. That 
way, instead of adding a new song as usual, it will update the current song card with the 
metadata. 
 
In the uncommon event that you change your mind after searching and no longer want to 
update the selected track, right-click anywhere in the library and choose “Release Selected 
Song”. That way, the next thing you download will be added to the library as a new song as 
expected and will not overwrite the selected song card.  
 
However, even if you forget to do this step, MusicMaster will still detect a mismatch between 
the selected song and the downloaded song. To resolve this, it may prevent the very next song 
from being automatically ingested. If this happens, you can use the “Scan For Missing Files” 
button in Tools > Options > Music Store Options to recover the song.  
  

Browse I Like Music Playlists 
The Search Page also has a Playlists option which shows lists of songs from popular music 
charts, as well as other lists that I Like Music maintains, such as new releases, genre or era lists, 
or music related to upcoming events and holidays.  
  
If your screen is wide, you’ll find the Playlists to the right of the search box. If you have a 
narrower screen, you’ll find an ILM Playlists button above the search box.  
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Reviewing Search Results 
Once you’ve searched for a song using any of the above methods, you’ll see a list of results. 
Depending on how wide you set your screen window, the list will have more or less detail. 
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If you are in a narrower view like this, you will see two icons to the right.  
 

 
 

You can click the play icon to hear the song audio. Keep in mind, this will be a compressed 
version for the web, and not the uncompressed wav you will receive upon download.  
 
Click the ‘i’ button to view all track metadata and download options.   
 
ILM groups multiple versions of songs. You can click the See All button to view the different 
versions. To tell which version is which, make your Store panel wider to display more info. 
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In this wider view, a clipboard icon appears between playback and info. This is used to add 
songs to a Project, which functions like a shopping cart. More on this later.  
 
If you go even wider, you can access the download icon right from the search results.  

 
 

Reviewing Song Info 
When you click the ‘i’ icon, you will see all available metadata for the song.  
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There will be three icons displayed either on the left side (medium view) or top (wider view). 
 

 
 
The big down arrow with musical notes on it downloads the audio file with metadata. (1 credit) 
 
The page icon downloads an XML file that contains only the metadata. (Free) 
 
The clipboard icon adds the song to a Project. 
 
We’ll look at each of these options in depth next. 
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1 - Download Audio File (with Metadata) 
This is the option you will use if you are trying to purchase new songs, since it includes both the 
audio file and all the metadata.  
 
When you click this button, you will be prompted to Open or Save the file. Be sure to select 
Save. 
 

 
 
You will also have to navigate to the downloads folder you specified in the Music Store setup. 
Remember it will default to Windows Downloads the first time you use the Store, but once you 
save to a new folder, it will remember that location for next time.  
 
Also remember, you must not change the filename at this point.  
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Once you click Save and the file downloads successfully, you should see the song appear in the 
Category you specified in the Music Store settings. You may need to double-click the category 
in the InfoBar to reload the category.   
 
Remember if you want to see the metadata you’ve downloaded, add those fields to your 
Library Grid using the toolbar option.  

 
 
2 - Download Metadata Only 
You’ll note there is an option to download metadata only. You should not need to use this 
when you purchase a song, because the metadata is included. If you were to use this feature to 
add metadata, be cautious as you may be replacing vital information, such as your song 
filename. If you don’t download the actual WAV audio from the store, this would result in 
missing audio.  
 
3 – Save Song to Project 
The clipboard button adds the song to a Project. You can think of this as a sort of shopping cart. 
It can hold up to 25 songs and then you can download the entire project at once. This combines 
all the songs into a single zip file. If you unzip the audio files into the same download folder, 
they will ingest and be available for playback, but you would have to manually perform that 
unzip step. 
 

Viewing a Project 
Click the Project option in the menu to see the songs currently stored in your project.  
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You can make the screen wider to see more options.  
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Here, you can listen to each song, download each individually, view details, or download 
metadata. You can also move songs into a new order in the project or use the checkboxes to 
select multiple songs and perform mass functions such as download or delete.  
 
To see all Project functions, click the menu button (narrow view). If you have a wider view, 
you’ll see all functions listed across the top of the screen  
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Menu options in narrow view: 

 
 
Menu bar options in wider view: 
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Among the options, you can listen to, download or remove all songs. Or you can remove only 
the songs you’ve selected with the checkboxes. You can also Save the Project after making 
changes. 
 
Save to Playlist 
Another option is to save the project contents to a Playlist. Playlists allow you to save song lists 
for later use. It’s like saving the contents of your shopping cart so you can return to the store 
later and either view them, or add them back into your cart and check out. You can access 
Playists by clicking “My Playlists” found in the menu or top bar.  

 

 
 

 
 
When you open your Playlists, you have several options: 
 

 
 
You can listen to the entire playlist, export a .CSV file with song info, share the playlist via email, 
or delete the playlist. If you choose to Open in Project, it will clear whatever you have in your 
current Project and add the Playlist songs instead. Think of this like clearing your shopping cart 
and replacing it with the contents of a saved cart so you can download those songs. If you had 
something else in your cart (Project) that you wanted to keep, you may want to store it as a 
Playlist first.  
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Download Report 
There is another option on the menu which we have not covered yet. This is called Download 
Report. This will allow you to access a report of the songs you have downloaded within a 
certain time period.  
 
Type in the dates you want and click Search. If it finds any downloads you can use Export track 
list to generate a report.  
 

 
 

Questions? 
If you have any other questions about using the store with MusicMaster, please contact your 
MusicMaster support rep or reach the team at 262-825-4000 or support@musicmaster.com.  
 
If you have questions specifically about the I Like Music service, you can find a user manual on 
their website here: 
 

https://www.ilikemusic.com/ilm-media/members/index.cgi?template=userguide 
 
 

 

mailto:support@musicmaster.com
https://www.ilikemusic.com/ilm-media/members/index.cgi?template=userguide
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